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 ABOUT THIS GUIDE

Copyright
No part of this document may be reproduced or transmitted in any form or by 

any means, electronic or mechanical, including photocopying and recording, 

for any purpose without the express written consent of SilhouetteFX, LLC.

Copyright © SilhouetteFX, LLC 2018. All Rights Reserved

July 20, 2018

About Us
SilhouetteFX brings together the unbeatable combination of superior software 

designers and visual effects veterans. Add an Academy Award for Scientific 

and Technical Achievement, 3 Emmy Awards and experience in creating visual 

effects for hundreds of feature films, commercials and television shows and you 

have a recipe for success.
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 WHAT’S NEW IN 6.1.14 - 7/23/2018

Features

Allow Backups To Be Stored In A Global Location
A global location for project backups can be specified with the 

SFX_BACKUP_DIR environment variable. This is similar to 

SFX_AUTOSAVE_DIR, and allows backup files to be stored outside of the 

project bundle.

Import SXR as Multi-View Stereo Images
SXR files are now imported with stereo L/R already hooked up.

Morph > Use Input Alpha
Added a Use Input Alpha option that ignores the transparency value and just 

warps the input alpha.

Paint > Duplicate L>R and R>L
You can now duplicate the selected paint strokes L>R or R>L, instead of the 

previous behavior of duplicating all strokes.

Scripting > Viewer Proxy Mode
Added an attribute for viewer proxy mode.

Bug Fixes

Camera Shake
Camera Shake was not working at some speed settings.

Color Node and Resize Crash
Connecting a Resize node to a Color node and then adjusting the Resize node 

caused a crash.

Color To Alpha Node Missing on Linux
The Color to Alpha node was missing on Linux which could cause Silhouette to 

crash when accessing the Composite tab.
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Depth
Render
A recent update prevented the depth channel from rendering.

View Depth at Proxy Resolutions
In the Depth node, the depth map did not display correctly at proxy resolutions.

Nuke Exporter Problem - Open Shapes
B-Spline and X-Spline open shapes in a sub layer would export without 

animation.

Nuke Tracker Import More Robust
Nuke tracker import is more robust and handles different Nuke tracker versions.

Paint > Clone Could Randomly Stop Working - Linux
On Linux only, a compiler optimizer bug could cause Clone filtering to short 

circuit and it would manifest in Clone not working or a rebuild of Clone strokes 

wouldn't work randomly.

Resize Crash
Resize could crash in certain situations.

Roto
Shape > Color > Fill Opacity > Brightness Difference
With Color > Fill Opacity enabled at an opacity less than 100%, enabling motion 

blur changed the brightness of the fill.

Shape > Color > Fill Opacity > Motion Blur and Black Edges
If Color > Fill Opacity was enabled on a shape with motion blur, there was a 

black border.

Outline Rendering Artifacts
If an outlined shape with round caps had end-points near each other, it could 

generate artifacts and slow down.
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Roto Blend 
Keyframes Not Visible in Timeline
Shape keyframes were not displayed in the Timeline when using the Roto 

Blend node.

No Input
Roto Blend now renders even without a source attached.

Shake SSF Export Crash
Exporting Shake SSF shapes caused a crash.

Tracker 
Import
Silhouette could not import a Nuke tracker that it exported.

Export - Linux
Exporting a tracker on Linux did not automatically append the filename 

extension.

Trees Window > Toggle Enable State Tool Tip Wrong
The tool tip for Toggle Enable State in the Trees window was E instead of d.

X-Spline Feather
In some cases, X-Spline shape points could not be feathered.
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 WHAT’S NEW IN 6.1.13 - 6/6/2018

Changes

Tree Window Shortcuts
The Trees window had hard coded E (Extract Nodes) and D (Disable/Enable 

Nodes) keyboard shortcuts. These shortcuts have been added to the 

keybinds.py file so they can be easily changed.

The new binds are at the end of the keybinds.py file:

fx.trees.bind("e", "ExtractNodes")

fx.trees.bind("d", "ToggleNodeEnable")

Bug Fixes

Round Open Shape Caps Problem
Round open shape caps had rendering artifacts on the last point.

Duplicating Shapes Set The Wrong Eye
When using Edit > Duplicate, Silhouette always set the copied view to the 

current view, rather than using the original object's view.

Command-line Render Range And Render Actions
The Command-line render range did not work with render actions.

Paint > Blur Brush Broken in 32-bit
Using the Blur brush in 32 bit projects caused corruption.

Paint Without Input Crash
Painting a stroke in an unconnected Paint node while viewing a different node 

would cause a crash. Attempting to clone from a clone source onto an 

unconnected foreground would also cause a crash.

Rendering to Chinese Paths
Silhouette could not render to Chinese paths. The render script failed when 

trying to print status for paths with non-ASCII characters.
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SGI Alpha Render Flipped
SGI Alpha only renders were flipped.

Save As Switched The Active Session
Using Save As when there were multiple sessions would set the wrong session 

after the save completed.

Tracker Importers Fail
Attempting to import a tracker failed unless it was an AE tracker.

Transform > Mode
The Transform node’s Mode pop-up menu was mistakenly removed in the last 

point release.

Undo System Out of Sync
An Undo System Out of Sync error appeared after loading Nuke trackers.
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 WHAT’S NEW IN 6.1.12 - 4/26/2018

Features

Depth Node
Antialiasing and Render to Alpha controls were added to the Depth node.

Antialiasing
Controls whether depth shapes are antialiased on their edges.

Render to Alpha
Renders the depth channel to the alpha channel.

Respect Frame Step
The Player now respects Frame Step for scrubbing and tracking. In addition, 

the Cache > Preload Frames preference respects Frame Step as well.

Changes

Transform > Filtering
The filtering in the Transform tool has been improved.

Bug Fixes

Drag Brush Artifacts
The Drag brush left artifacts and behaved strangely with HDR images.

DOD Is Computed Wrong When Proxy Mode Not 1:1
When using a proxy in conjunction with ROI, the image DOD was computed 

incorrectly causing position issues.

Keyer Handled ROI Wrong
The Transform DOD was being taken into account when viewing the individual 

or combined mattes. This would cause the rendered result rectangle to not 

always match the ROI.
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Image Caching Problem When DOD Did Not Match Session
If an image is being centered with respect to the session, for example it's DOD 

does not match the session, then it can't be retrieved from the cache. So, 

changing the ROI will now reload the image in this situation.
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 WHAT’S NEW IN 6.1.11 - 4/02/2018

Bug Fixes

Command-Line ProgressHandler Broken (Windows)
The command-line progress handler would bail out too early on Windows.

Image Cache Could Crash Randomly (Windows)
On Windows, lookups in the image cache could crash randomly.

Paint Overlay Off By A Fraction
The Paint Clone overlay, in mix mode, was off by a fraction and was especially 

noticeable at high zoom values.

SFX_FORMATS_PATH Was Not Used
The SFX_FORMATS_PATH environment variable was not being used.

Timeline Crash With No Session
Moving the cursor into the Timeline header would crash if there was no session.

Changes

Bezier Behavior
Creating Beziers now have a new behavior. When clicking to add a new point, 

it will automatically set up the tangents to be linear, pointing in the direction of 

the last point. You can still hold and DRAG to drag out the tangents you want, 

but if you leave them they will stay at 10% of the distance to the previous point. 

If the previous point is also a cusp, it will update the outgoing tangent of that 

one as well. This change has two advantages: 1) it shows you some useful 

default tangents and encourages you to pull them where you want them if you 

need to and 2) it always sets the last control point to have a useful tangent, 

which avoids corruption for open shapes at the end (in both Silhouette and 

Nuke).
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Duplicate Behavior
Duplicate currently acts like a copy/paste, so it puts the copies into the active 

layer if there is one. This is non-intuitive if the copied object is the active layer 

itself. Instead, the duplicated objects are now pasted immediately above the 

top-most selected item. This way, when duplicating a single object, the 

duplicate appears directly above the original, at the same grouping level.
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 WHAT’S NEW IN 6.1.10 - 3/14/2018

Features

Alpha to Color
Composites each of the RGB channels together and places the result in the 

alpha. This is useful for working with shapes assigned to different RGB 

channels in Roto. Connect the Roto > Channels output to the Color to Alpha 

node and RGB mattes with corresponding alpha are created.

Display ROI Outline Viewer Preference
The Viewer > Display ROI Outline preference turns the ROI outline on and off.

Node.getDOD() Scripting Function
Added node.getDOD(port, frame) method.

Scripting Tweaks For Property
It was not possible to compare two properties to see if they were the same. In 

addition, it was not possible to get a property's parent object, to determine 

which node, session, source, etc the property is in.

Added Property.parent attribute. Added rich comparison to Property, Object, 

and Raster.

Show What’s New on Startup
On startup, if this is the first time launching a new version of Silhouette, it will 

open the What's New. It will only do this once. This behavior is controlled by the 

User Interface > Show What’s New After Installing A New Version preference.

Source Auto Selected After Importing
The source is now automatically selected after importing so you can then 

immediately press Ctrl-N(Win/Linux)-Cmd-N(Mac) to create a new session.
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Bug Fixes

Applying Point Trackers From Within Nested Layers
Applying point trackers from within nested layers did not work.

Object List Drag Crash
In the Object List, dragging a selected layer that had selected child objects 

would cause a crash. Now, it'll treat any selected child of a layer being moved 

as unselected, since they will be moved along with their parent anyway.

Open Spline Conversion to Bezier Problem
Some open splines would display corruption at the end points. Sometimes 

invisible within Silhouette, the exported shapes would display problems in 

Nuke.

Paint > Clone > Align Mode Update Problem
When there was a Clone offset, clicking on the Align button caused the Viewer 

to show only the unaligned offset. Moving the cursor back into the Viewer would 

then update the proper offset.

Paint Only Output Bug
The Paint Only output would not calculate its DOD properly in some cases.

Paint Only Stereo View Problem
When using the Paint node’s Paint Only output, you could not view both the left 

and right views in the Output node.

Painting in Stereo and Alpha
When painting in stereo, the right stroke’s alpha was not being stored.

Stereo Align Broken with ROI
Stereo Align did not work when using a ROI.
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 WHAT’S NEW IN 6.1.9 - 2/19/2018

Features

Can't Bind A Key To Ctrl+Alt+N
User keybinds can now override any stock menu/action bind, such as 

Ctrl+Alt+N, Ctrl+N, etc.

Negative Scaling - Layers
To easily flip or flop the orientation of a Layer, negative scale can now be used.

NVIDIA 3D Vision Glasses Support
NVIDIA 3D Vision glasses are now supported in the 3D Preview window. This 

is enabled using the Stereo > Enable NVIDIA 3D Vision Preview Support 

preference.

Planar/mocha Tracker Message
If a layer containing a shape is not selected when attempting to use the Planar 

or mocha trackers, the following message is displayed:

An active layer containing one or more shapes is required for tracking.

Rebuilding Paint That Used Multiple Trackers
Previously, Clone Brush paint strokes only used a single, selected layer when 

performing an Auto Paint > Rebuild. Now, the layer transform is stored in the 

paint history. This allows a Rebuild to work as expected when multiple layers 

were used to transform the Clone Brush paint strokes.

ROI Memory Enhancement
ROI now crops the source image on load resulting in significant memory 

savings.

Scripting - Store Project Properties
You can now store Project Properties in the project.
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Bug Fixes

Composite > Matte Input
The Composite > Matte input only worked with Alpha.

E Shortcut key in Paint > Clone Brush
The E Shortcut key in the Paint > Clone Brush did not work if there was a 

selected node in the Trees window.

Paint > Incremental Offset Preference Jumping
With the Paint > Incremental Offset preference set, it could jump when setting 

the Clone offset.

Roto > Composite Color Preference Did Not Update
The Roto > Composite Color preference did not update when changed.

Scripting: Recti Bugs
Recti.empty was reversed. Recti.left, top, right, and bottom were misreported.
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 WHAT’S NEW IN 6.1.8 - 12/11/2017

Features

Backtick Key (`) In Trees Window
The Backtick key (`) pops up a node context menu in the Trees window where 

nodes can be added.

Bug Fixes

Command-Line Crash
The Command-Line renderer crashed after the first frame when using source 

images containing certain meta-data.

Command-Line Render Message
The Command-Line renderer always printed out the following when rendering: 

Node not found OutputMultiPartNode.

mocha OFX Displayed Only 1 Frame
When the OFX version of mocha was applied, a single frame was displayed in 

the Viewer instead of the sequence.

Paint Crash After Resizing Session
If there were existing paint strokes and the Session Size was changed, a crash 

would occur when a new paint stroke was painted.

Output Start Frame Was Always Session Start Frame
When using either a custom or work range in the Render Options window, the 

rendered frames always started at the Session Start Frame and not the new 

Output Start Frame.

Resizing Stabilized Shape With Tablet Jitters - Mac
On Mac systems, resizing stabilized shapes with a pen/tablet would jitter.

Stabilize and Shape Bounding Box Points Appearance
The shape bounding box points nested within layers with extreme transforms 

appeared skewed when Viewer > Stabilize was enabled.
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Known Issues - Mac Only

Cursor Not Disappearing When Painting
The cursor does not disappear in the Viewer while painting when using a tablet.

Cursor Not Updating
The cursor doesn’t change when transitioning between some views.
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 WHAT’S NEW IN 6.1.7 - 11/15/2017

Features

Avoid Duplicate Names in Exported Nuke Shapes
Nuke can’t handle shapes and layers with the same name, so the exporter now 

generates unique names if necessary.

Splash Screen on Startup
Enabled splash screen during startup.

Bug Fixes

Bezier Spline Conversion - Size Differences
There was a size difference when converting open B-Spline or X-Splines to 

Bezier shapes.

Tree View Crash
Under certain circumstances, clicking in the Trees window would cause a 

crash.

X-Spline Open Shape End Point Artifact
End points of some open X-Splines could have an artifact on the shape’s end 

point.

Zoom and Pan Problem
If the zoom pop-up menu was set to 200% or 300% in the Viewer and then the 

Space-Bar was used to pan, the image in the Viewer snapped to 100% zoom.
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 WHAT’S NEW IN 6.1.6 - 11/10/2017

Bug Fix

Nuke 9+ Shapes Export Issue
In some cases, X-Spline and Bezier shapes exported to Nuke with feathers 

when there wasn’t any.
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 WHAT’S NEW IN 6.1.5 - 11/07/2017

Features

Move Keyframes Beyond Session Start and End Frame
Keyframes can now be moved beyond the Session’s start and end frame. This 

is useful to create shape motion blur on the first or the last frame of the Session. 

Note: it is necessary to enable Show Work Range in the Timeline’s context 

menu to move keyframes outside the Session time range.

Timeline > Show Work Range
The Timeline has a new context menu option called Show Work Range. When 

enabled, the Timeline displays the start and end frames of the Work Range 

instead of the Session time range. 

Changes

Single-click Select Nodes
Instead of double-clicking, single-clicking the center of a node will now 

simultaneously view and edit a node.

Bug Fixes

Depth Preview Problems
• When the source was larger than the Session, a shape's position in the main 

Viewer did not match the Depth Preview.

• When the source was larger than the Session, the Depth Preview displayed the 
original image size and not the Session size.

Drag and Drop In Object List - Mac
In some cases, there were drag and drop issues in the Object List on the Mac.

Open B-Spline End Point Feather Handle
The end point feather handles of an open B-Spline shape were not 

perpendicular to the curve path.
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Undo Issues When Using Pen/Tablet
Undo would stop working under certain circumstances when using a Pen/Tablet 

in the Trees window.
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 WHAT’S NEW IN 6.1.4 - 10/16/2017

Features

Output Multi-Part Node - More Inputs
The Output Multi-Part node can now have multiple additional inputs. Right-

click on the Output Multi-Part node and select Add Input. Right-click on an 

input port to remove it. You can add as many inputs as you want, but the inputs 

will get smaller.

Bug Fixes

Command-Line Renderer Gets The Range Wrong
The Command-Line renderer would get the range wrong if the -start option was 

used.

Crash in Trees Window
There was a crash when opening the node list context menu after deleting a 

node.

Depth > Blur and Wrap Artifact
When adjusting a shape’s Blur or Wrap in the Depth node, there was a box 

artifact.

Open B-Spline With Feather Crashed in Nuke 11
Open B-Splines with feathering caused a crash in Nuke 11 when imported.

Save Project Via Scripting
You can now save a project via scripting as Save As without replacing the 

current project. Added a new method, project.copy(path), which just copies the 

project to the new path, and leaves the existing one alone. 

Tablet Support In Trees Window
• Added status bar tips for hovering over ports and edges in the Trees view when 

using a pen and tablet to work around a bug in Qt regarding tablet events not 
triggering tool tips.
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• Hold SHIFT while pressing the middle-mouse button and drag down to zoom out 
and drag up to zoom in.

•  ALT+tapping on a node will activate it without allowing it to move.
Silhouette v6 What’s New    
• 
• 
•
•
•



   Si

24 What’s New in 6.1.3 - 9/25/2017

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

 WHAT’S NEW IN 6.1.3 - 9/25/2017

Features

Command Line > -open_project
Added the -open_project command-line switch to open the project browser on 

launch.

RE:Vision Effects OFX Support
Silhouette v6.1.3 now supports the current OFX versions of all RE:Vision 

Effects products.

Scripting Additions
• global fx.buildDate, fx.versionString, fx.versionMajor, fx.versionMinor attributes

• fx.activate(node) will make the node active

• fx.activate(project) will make the project active

• fx.getNodeInfo(node_id) returns detailed static node information

• fx.loadSessionFormats(path) to load additional formats.xml files

• object.propertyList returns properties in order they are added

• project can be reloaded with project.load()

• property.info attribute returns detailed static property information

• sessions can be created from Python

• tools/session.py - SessionBuilder() helper for creating sessions

• tools/preset.py - preset helper for parsing presets.txt file

• un-saved project can be created with p = Project()

Bug Fixes

OFX
Display OFX Parameter Names That End In . Properly
An empty label was displayed if an OFX property name ended with a period.
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Pixel Scale Property Was Reversed
The OFX pixel scale property was inverted, causing on-screen controls for 

some OFX plug-ins to be rendered the wrong size.

Support OFX Slider Display Min/Max & Valid Min/Max
We now support OFX plug-ins that have a valid range and a display range for 

sliders.

Paint > Clone Brush Tablet Problem - Linux
There was a bug on Linux where the clone offset could not be set with the 

tablet.
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 WHAT’S NEW IN 6.1.2 - 7/28/2017

Bug Fix

Tablet Editing Problem - Linux
With certain tablets, shape points could not be edited.
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 WHAT’S NEW IN 6.1.1 - 7/21/2017

Features

GPU Fix For Older GPUS
Added support for older graphics cards.

Bug Fixes

File Path Change Not Noticed
Changing a file path required a restart of Silhouette.

Light Wrap Crashed When There Was No BG Input
Light Wrap crashed when there was no background input.

Nuke 9+ Exporter Problem
Exporting shapes to Nuke would fail in certain cases with multiple nested 

layers.
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 WHAT’S NEW IN 6.1 - 7/11/2017

Features

Auto Paint > Paint History Custom In/Out Enhancement
To provide a faster way to set custom in/out points in the Auto Paint > Paint 

History, arrows were added to each numeric field which enter the currently 

parked frame when clicked.

Copy Alpha to RGBA Shape Preference
A Copy Alpha to RGBA shape preference was added.

MultiFrame Range Improvement
When using MultiFrame and adjusting which keyframes were affected, there 

was no feedback to show if you were just tweaking the in/out point or sliding the 

whole range. Now, the MultiFrame range is displayed in the status bar while it 

is being edited.

Nuke 9+ Shape Exporter Enhancements
There are a number of enhancements to the Nuke exporter for proper rendering 

of shapes, feathers and mocha perspective transformations in addition to 

increased accuracy. Also, Alpha values can be repeated in the RGB channels 

as an export option.

Notes: 

1 If there are no mocha perspective transformations, the handles of feathers and 
open shapes will render correctly in Nuke. 

2 If there are mocha perspective transformations:

• The output is correct but feather and open shape handles will appear to be very 
long. This is a Nuke user interface bug.

• In Nuke, if a feather point is added using the E key, the feather point will be far 
away and have to be dragged back to the desired location. This is another Nuke 
user interface bug.

Read formats.xml From Outside Of Resources
A SFX_FORMATS_PATH environment variable was added which can be the 

complete path to an xml file containing the desired formats.
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Scripting
Create And Select A New Project Via Scripting
Added a way to create a new project with a complete bundle name and then 

have the UI select it.

syntax:
project = Project(bundle_path)
activate(project)
project.save() 

object_renamed hook
For when objects get renamed, added object_renamed hook and the callback 

gets the object.

Shape Import Using Python
Shapes can now be imported using Python.

Timeline Frame Range
The Timeline now always shows the full session range with the work range 

displayed using a gray bar at the top of the Timeline. The work range can 

quickly be adjusted by: 

• Ctrl-drag the ends of the work range bar to change the start and end.

• Ctrl-drag the work range bar to slide it forward and back while maintaining the 
duration.

• To center the timeline on the current frame, click the top left corner of the Timeline 
above the object labels.

Timeline Markers
The Timeline context menu now has a Marker option which allows for the 

creation, editing or deletion of markers. Timeline Markers are a handy way of 

placing notes at specific points in time. Markers are displayed as light blue 

squares at the top of the Timeline.

When you right-click in the Timeline and select Marker > Create/Edit, a dialog 

box opens where you can enter, change, or clear text. When you enter text and 

click OK, a marker is displayed.
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Visual Warning for Paint > Clone > Grade/Filter Controls
The Paint > Clone > Grade and Filter controls are hidden in tabs so we have 

added a visual indicator in the tab if the controls have been modified.

Changes

Clone Reset Behavior
Previously, Clone Reset only reset the Transform controls. Now, all clone 

parameters, including Grade and Filter parameters are reset.

Composite Resolution
Previously, the DOD (Domain of Definition) was determined by the background 

clip of a composite. Now, the union of the foreground and background 

determines the DOD.

Point Tracker > Smooth Behavior
In the Point Tracker, the Smooth option will no longer be available if there are 

no visible selected trackers. Smoothing will only smooth visible trackers.

Point Trackers Within Layers
Silhouette now allows Point Trackers to be added and tracked within layers.

Bug Fixes

Alpha Overlay Was Affected By OCIO Viewer Controls
Alpha and color overlay are no longer affected by the viewer OCIO controls.

Cache Display Not Working - Windows
The Cache Display would not work on Windows in certain situations.

Import Footage With No Project Crash
When there was no project, it was possible to double-click in the Sources 

window to import footage which caused a crash.

Missing Frames - Macintosh
In some cases, frames would display as black after opening a project.
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Nuke Tracker Importer Problem
mocha tracks pasted into the Nuke tracker did not import into Silhouette.

Panning and Beeping
Holding the Space key and panning could cause beeps to occur during auto-

repeat.

Session > New Session Crash
When there was no project, it was possible to select Session > New Session 

which caused a crash.

Tablet Problems - Macintosh
Some Mac users were experiencing strange tablet behavior in the Roto node.

Text Box Focus Behavior 
If the cursor was in a text field and the cursor was moved into any major view, 

it would steal the focus. You know have to press the Tab key to leave the focus 

of a text field. 

Timeline Keyframe Paste Problem
Pasting keyframes from two shapes did not paste the proper keyframes into the 

first shape.

Timeline Not Displaying Tracks At Startup
In some instances, the Timeline did not display tracks at startup.

zMatte Crops Output When Deartifact Was Enabled
zMatte’s Composite output was cropped to the foreground when Deartifact was 

enabled.
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 WHAT’S NEW IN 6.0.33 - 5/10/2017

Features

EXR Multi-View
If the EXR output extension is sxr, the EXR module will write out a multi-view 

file. Otherwise, it writes a multi-part file. 

Note: This will only work if there are only left and right views.

OFX
Silhouette now supports RE:Vision Effects Twixtor and ReelSmart Motion Blur 

OFX plug-ins.

Roto Node > Color Comp View Mode
A Color Comp view mode has been added to the Roto node. The shortcut key 

is 4.

Save Paint History With Auto-Saves
The Paint history is now saved along with the auto-saves. A rotating list of 

backup paint histories are stored in the respective paint data directory so you 

can choose the one you want.

View Paint (Shift-0)
When View > Paint is selected in the Paint node, Shift-0 displays paint strokes 

over black.

Changes

Linux - Python 2.7
Silhouette v6 requires Python 2.7 with UCS4 support. If you are running an 

older distribution, we have packaged Python 2.7 as a convenience. To enable 

the internal Python (i.e. if you don’t already have Python 2.7), uncomment the 

PYTHONHOME line in the run.sh script.
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Fixed Bugs

DVE Crash
The Transform node could crash in when used in conjunction with certain 

nodes.

EXR Compression Parameter Display Problem
When you added an Output node, the custom module parameters were not 

created until you actually selected the module from the list again.

Paint and Match Node Crash
Silhouette would crash if a Match node was used before the Paint node.

Pasted Nodes Did Not Get A New Label
Pasted nodes had the same name as the original. They are now incremented 

by 1.

Render - Output Directory Variables
Variables were not expanded in the path portion of the output path. For 

example, an output path of "$(HOME)/output" was not properly expanded with 

the HOME variable replacement.

Scripting
Cloning a Project Returned The Wrong Type
Cloning a project via scripting returned an Image object instead of a Project 

object.

Object_Created Did Not Get Proper Type
In the object_created hook, the created object had the base Object type but not 

the subclass type.

User-Defined Properties Should Remember Their Positions
If user-defined properties were inserted between default properties, they 

loaded back in at the end.
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 WHAT’S NEW IN 6.0.28 - 3/07/2017

Fixed Bugs

Nuke 10 Tracker Import
Nuke 10 trackers will now import into Silhouette. In addition, trackers with a 

start frame other than 1 will now import into Silhouette as long as the Silhouette 

start frame matches the Nuke start frame. 

Output Multi-Part Node Missing on Windows
A recent update mistakenly removed the Output Multi-Part node on the 

Windows version.

Temporary Paint File
We create a temporary paint file called sfxpaint.dat used for undo events. The 

file is only deleted when Silhouette is closed and could get quite large. In 

addition to deleting the temporary paint file when Silhouette is closed, it is also 

now deleted when the project is switched.
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 WHAT’S NEW IN 6.0.27 - 2/17/2017

Fixed Bugs

Renders 1 Frame Short
A recent update caused the last frame of a sequence to not be rendered. This 

also affected rendering the current frame.
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 WHAT’S NEW IN 6.0.26 - 2/15/2017

Features

Scriptable Custom Button Property
A custom button property can now be added with a script callback function.

Changes

Scripting -> object.properties Attribute Is Now A Normal 
Python dictionary

Any scripts that iterated over object properties should be updated.

Fixed Bugs

Holdout Composite Crash
Holdout Composite would crash if only one input was connected.

Linux Node Crashes
A compiler error in a recent Linux update caused crashes with the following 

nodes: Bump Distort, Chromatic Aberration, Keystone, Lens Distortion, Morph. 

Roto Blend, Scatter and Turb Distort.

Renderer Did Not Support A Specific Frame Set
The command-line renderer -range option did not work. 

Scripting
Added Proper Indentation in Code Editor
Tab and Shift-Tab now properly indent (and un-indent) blocks of code.

Adding An Empty Group Property To A Node Caused A Crash
When adding a custom group property with no children to a node, the property 

view crashed.
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node.properties Did Not Act Like A Real Dictionary
We originally created are own dictionary interface to the internal prop-list, but 

instead rewrote it to use a normal Python Dict and now it behaves as expected.

X-Ray Render Problem
The X-Ray node was not rendering correctly.
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 WHAT’S NEW IN 6.0.25 - 1/24/2017

Features

Linearize Images In Mocha Pro
If you are using rec709 8-bit images, enable the Mocha > Linearize Images In 

Mocha Pro preference and they will look correct in the Mocha user interface.

Fixed Bugs

EXR Alpha Automatically Opaque
EXR files without an Alpha channel automatically had a an opaque Alpha 

channel once imported into Silhouette.

Render Options > Output Start Frame Not Obeyed
The Output Start Frame number was not obeyed in some cases.
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 WHAT’S NEW IN 6.0.24 - 1/11/2017

Fixed Bugs

Roto - Nuke 9+ Export Problem With Nested Transforms
In some cases, nested transforms were not being exported correctly to Nuke.
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 WHAT’S NEW IN 6.0.23 - 1/10/2017

Fixed Bugs

Roto > Input Alpha and Motion Blur Crash
Fixed an issue that caused sources with input alpha to crash when using Roto 

shapes with Motion Blur.
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 WHAT’S NEW IN 6.0.22 - 1/09/2017

Features

mocha Pro OFX v5.2.1 Plug-In Compatibility
Silhouette is now compatible with the mocha Pro OFX v5.2.1 plug-in.

Fixed Bugs

Linux Centos 7 Error
On some Linux Centos 7 systems, Silhouette would fail to start with the 

following error: The application failed to start because it could not find or load 

the qt platform plugin xcb.

Roto - Copy/Paste Order Of Roto Objects Not As Expected
In certain projects, the order of pasted objects did not match the original 

selection.

Roto - Input Alpha Motion Blur Problem
The input alpha was not computed properly when Motion Blur was enabled and 

caused corruption.
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 WHAT’S NEW IN 6.0.21 - 12/19/2016

Features

User Interface > Trees > Connections Preference
A User > Interface > Trees > Connections preference with Curved and Straight 

options was added.

Fixed Bugs

Output Start Frame Wrong in Render Window
A modified Output Start Frame in the Render window was off by one the next 

time you opened the Render window.

sfxcmd -info Crash
The sfxcmd -info command-line could crash when running scripts.

Undo Crash With Non-Keyframed Splines - Linux
Fixed a Linux compiler bug which would cause a crash when undoing a change 

to a non-keyframed spline.

Copy Node Naming Error
Copying nodes resulted in both nodes getting the same name.
lhouette v6 What’s New



• 

What’s New in 6.0.20 - 12/09/2016  43 

• 
• 
• 
•
•
•

 WHAT’S NEW IN 6.0.20 - 12/09/2016

Features

Action > Time > Shift Source Time
A source sequence can be shifted in time by inputing both the source frame and 

the destination session frame. This automatically calculates and sets the 

Source node’s Time Shift parameter.

Render Only Alpha Parts to EXR
Silhouette now supports rendering alpha only multi-part files.

Scripting
Add User-Defined Property Groups
Property groups previously could not be defined. A Property with no value is 

now a group. Info dictionary attributes are "expand" (True|False). To put a 

property into the group, prefix the property name with <group_name> and dot. 

For example, group.property.

Order Actions
You can now control the order of Actions and Action menus. Action has a new 

"order" argument that can be set to an index. The default is -1, which means to 

use alphabetic order (the default). Actions can also be placed in the File and 

Edit menus by specifying the optional "root" argument with the string "File" or 

"Edit".
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Fixed Bugs

EXR Render Crash - EXR Parts With Same Name
SFX crashed when trying to render multiple EXR parts with the same name.

Mocha Floating License Not Returned Until Exit
Instead of checking in a mocha floating license when leaving the mocha tab, it 

was not returned until Silhouette was exited.

Roto Node > Blur Crash
Silhouette would crash when the Roto node’s blur was adjusted.
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 WHAT’S NEW IN 6.0 - 12/01/2016

Silhouette v6 is a fully featured, GPU accelerated compositing system. Its 

standout features are award winning rotoscoping and non-destructive paint as 

well as keying, matting, warping, morphing, and a total of 136 different nodes-

-all stereo enabled. 

Features

Trees and Nodes
Trees
The power of Silhouette lies in the Trees window where your effects are built. 

A tree is a series of clips and nodes, such as color correction, image processing 

and composite nodes, plugged together to create the desired effect. The tree 

is grown by adding clips and nodes in any order. The ability to view any node 

while editing another allows for very complex composites that can be set up 

and rendered in one pass.

Nodes
Silhouette is now a GPU accelerated node based system with 137 different 

nodes used for various functions. Located in the Nodes tab at the bottom of the 

screen, nodes are grouped into the following categories: 

Color
Black and White, Chromatic Aberration, Color Correct, Defringe, Develop, High 

Contrast, Invert, Kelvin, Low Contrast, Match, Polarizer, Printer Points, 

Selective Color Correct, Shadows/Highlights, Telecine, Tone Adjust, Vignette.

Composite
Alpha to Color, Color Paste, Composite, Copy, Drop Shadow, Edge Composite, 

Fade Color, Grain Composite, Holdout Composite, Light Wrap, Math 

Composite, Mix, Non-Additive Mix, Optical Dissolve, Premultiply, Slap Comp, 

Swap Channels, Switch Matte, Unpremultiply.
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Diffusion
Center Spot, Depth of Field, Diffusion, Double Fog, Fog, Halo, Net, Rack 

Focus, Silk, Split Field.

Filter
Blur, Bump Shade, Deartifact, Deband, Deblock, Deflicker, Defog, Degrain, 

Despeckle, Detail, Displace, Edge Detect, Grain, Mosaic, Scatter, Scratch, 

Sharpen.

Film Lab
Bleach Bypass, Cross Processing, Film Stocks, Grunge, Overexpose, Three 

Strip, Two Strip.

Image
Checkerboard, Color, Color Bars, Depth, Fractal Noise, Grid, Linear Gradient, 

Merge Views, Null, Output, Output Multi-Part, Paint, Radial Gradient, Roto, 

Roto Blend, Split Views.

Key
Color Suppress, Difference Matte, Matte Repair, Power Matte, Screen 

Smoother, zMatte.

Light
Glow, Glow Darks, Glow Edges, Rays, Reflector, Relight, Star, Streaks.

Silhouette
Depth, Morph, Output, Output Multi-Part, Paint, Power Matte, Roto, Roto 

Blend, zMatte.

Special Effects
Cartoon, Color Infrared, Color Shadow, Day for Night, Harris Shutter, Infrared, 

Looks, Night Vision, Pastel, Pencil, Texture, X-Ray.

Time
Retime, Time Blur.

Tints
Color Gradient, Color Spot, Colorize Channel, Colorize Gradient, Dual 

Gradient, ND Gradient, Photographic, Radial Tint, Split Tone, Sunset, Tint.
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Transform
Camera Shake, Crop, Flip, Flop, Keystone, Resize, Tracker, Transform.

Warp
Bump Distort, Lens Distortion, Morph, Turb Distort.

Presets
Visual presets for most nodes.

Featured Nodes
Roto

Feathering
Open Shape Feathering

Opens shapes can now be feathered.

Per-Point Feathering

Feathering is now implemented for every point in the shape so as to be 

compatible with Nuke.

Open Shape Cap Style
A Cap Style parameter has been added for open shapes. You can choose from 

Flat or Round end cap styles.

Nuke 9+ Exporter
Silhouette will now export open/closed shapes, the shape feather, opacity, 

blend mode, invert, motion blur, outline color, fill color, shape blur (inner and 

outer blur only), and visibility. The layer’s blur, visibility and motion blur are also 

exported in addition to the node blur. You can optionally fully bake shape and 

transform data, convert opacity to Nuke Lifetime, and export the Silhouette 

project name.

Render Shape Outlines
Shapes in the Roto node can now be rendered as outlines over the image.

Paint

Speed
Switching frames after painting is now instantaneous, even with large images, 

as a result of the frames being saved in a background thread.
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Trackers
Paint can now utilize Trackers from any node that produces them. Just connect 

the Objects output of any node that produces Trackers into the Paint node’s 

transform input (colored yellow) located at the top right of the node. You then 

select which tracked layer to use from the Paint tab’s Transform pop-up menu.

ROI Compatibility
Paint is now compatible with ROI (Region of Interest) so you can paint on a 

much smaller area of a larger image.

Clone
Blur Aspect

Allows differing amounts of blur on the X and Y axis. Blur Aspect is along the X 

axis, so setting the aspect to 2 would be twice as much blur horizontally than 

vertically.

Filtering

The Clone filtering has been improved for all filtering methods.

On-Screen Controls - Corner-Pin

The mouse, pen/tablet or Arrow keys can now all be used to move corner-pin 

points after first selecting them with the Ctrl(Win)/Cmd(Mac)-1,2,3 or 4 keys 

corresponding to the top left, top right, bottom right and bottom left corner 

points. Pressing Ctrl(Win)/Cmd(Mac)-1,2,3 or 4 a second time deactivates the 

mode. This is useful when Interactive mode is disabled or when you are 

zoomed into the image.

Obey Matte On All Inputs
The alpha of all incoming inputs can be used as an Obey Matte source.

Drag Brush - Alpha Behavior
The Drag brush now draws into the alpha channel identically to the RGB 

channels.

Depth
The Depth node contains a dedicated tool set for creating depth channels.
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Shape Gradients
Silhouette's industry leading rotoscoping and shape tools have expanded 

functionality in the Depth node. New shape parameters include depth and 

gradient control.

Depth Tools
Alongside the powerful rotoscoping tools, the Depth node adds a number of 

depth tools that make quick work of common depth map tasks. The time-saving 

tools include Constant, Horizon, Ramp, Hall, Tunnel and an Alpha object which 

converts the alpha channel hooked into the Depth node’s Alpha inputs into a 

depth map.

Depth Preview
The Depth Preview window in the Depth node displays a 3D view of the depth 

map. It is very useful for visualizing the depth and placement of objects in 3D 

space. Clicking and dragging will move the image around in a perspective view.

Roto Blend
The Roto Blend node smoothly blends the opacity of shapes together. This is 

very useful for creating depth mattes which can then be further manipulated in 

the Depth node.

Tracker
Previously, the Tracker tool was only available in certain nodes. Now, a new 

Tracker node can be plugged into other nodes that contain trackable items so 

that they can directly make use of transformed layers.

OFX
OFX plug-ins are now supported. At the current time, Genarts Sapphire has 

been qualified to run in Silhouette.

Region of Interest
The ROI (Region of Interest) tool crops the image in the Viewer to a user 

defined size and can be animated. This is especially useful when you only need 

to work within a smaller region of a larger image as it will use less memory and 

process faster. If expanded, the ROI will display overscan pixels which can then 

be manipulated.
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Resolution Independence
Although Silhouette Sessions are a fixed size, sources of different resolutions 

can be used. Overscan areas of sources larger than the Session are never 

clipped and are accessible with either a Transform node or expanding the ROI 

(Region of Interest).

Actions
Batch > Rename
Renames selected objects to match the first selected object.

Keyframes

Select All
Selects all keyframes.

Select Layer
Selects all layer keyframes.

Select Shape
Selects all shape keyframes.

Select Tracker
Selects all tracker keyframes.

Select > Single Point Shapes
Selects single point shapes.

Preload Frames
Source frames are automatically cached in a background thread. The amount 

of frames preloaded is controlled by a Cache > Preload Frames preference.

EXR Enhancements
• EXR multi-part files can be rendered using the Output Multi-Part node.

• The EXR data window is fully supported and the ROI (Region of Interest) is saved 
as an output EXR data window.

• When creating a new session based on an EXR file, the session size will use the 
display window but the data window will appear in the proper place, and overscan 
is available.

• The metadata contained in EXR files is now passed through to the rendered file.
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Scripting
There are a number of scripting changes in v6. See the Scripting Guide for 

what's new.

User Interface
Curve Editor
The Curve Editor is a view mode in the Timeline that allows you to work with 

keyframe animations expressed as curves on a graph. It lets you visualize the 

interpolation of the animation.

Preferences

Cache > Preload Frames
Controls how many source frames are preloaded into the cache.

Paint > Default Source
Sets the clone source default.

Shape > Hide Outlines During Edit
When activated, the shape outline is hidden when editing.

User Interface > Colored Timeline Tracks
Colors the timeline tracks the same as the Roto node’s shape colors.

Retina Support
The Silhouette user interface has been upgraded with Retina display support 

for Macintosh systems.

Snapshot
Captures the image in the Viewer so that it can be compared with other nodes 

or Viewer modes using Toggle Snapshot, Vertical Split, and Horizontal Split 

snapshot modes.

Timeline > Select All Keys
When hovering over a track, Select All Keys will select all keyframes for that 

track. If not over a track (empty area), it will select all keyframes in the timeline.
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Workspaces
Custom workspaces can be saved/deleted through the new Window > 

Workspace menu.

Changes

Composite > Background Color Preference Removed
The Composite > Background Color preference has been removed. Now, if you 

use only one input of a multi-input composite node and select View > 

Composite, the background color will default to black.

Crop Node Now ROI
The Crop node has been converted to a ROI (Region of Interest) Viewer tool.

Disk Cache Removed
As Silhouette has evolved to a more complex node based system, disk caching 

has been removed and replaced with a Cache > Preload Frames feature. See 

the features section for more information.

Feather Tool Removed
The Silhouette v1-v5 Feather tool is no longer visible in the Toolbar as 

feathering now takes place in the Reshape tool. Projects with Silhouette v1-v5 

feathering can be loaded and the old Feather tool will appear.

The feathering method used in Silhouette v1-v5 can still be used by enabling 

the Shape > Enable Legacy Feathering preference. This will force the feather 

tool to appear in the Toolbar. However, you will not be able to export the 

feathering data to Nuke as it is not compatible.

Multiple Shape Selection & Bounding Boxes
Previously, the bounding boxes of all shapes in a multi-shape selection were 

displayed in Transform mode and was distracting. Now, only the combined 

bounding box is displayed.

Node Inputs
The Inputs menu in the Viewer has been removed since node inputs are now 

hooked up within the Trees window.
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Node Outputs
Some nodes have multiple outputs. For instance, the Roto node has Output, 

Composite, and Channels outputs and the Paint node has Output and Paint 

Only outputs.

Nuke Tracker Import
Silhouette now imports Nuke 8 and above trackers.

Project Folder and Filename
The project folder and filename can now be named identically by setting the 

following environment variable: SFX_PROJECT_IS_BUNDLE=1

Quicktime
Quicktime is no longer supported.

Render Options Window / Output Node
The Output node is where you now specify the file name, file type, and 

channels to render. The Render Options window only deals with which nodes 

to render, frame range, resolution, field handling and whether to apply a region 

of interest.

Render Shapes to Channels
The Render Shapes to Channels action has been removed as it can be 

achieved by using the Roto node’s Channels output.

Session Creation
• The New Session dialog no longer has the ability to choose which nodes to add. 

The Nodes window is where you select the nodes you will be working with.

• There is a Session > Default Type preference that lets you choose from 
Composite, Roto and Paint session types. When set to Roto or Paint, a Roto or 
Paint node is automatically added when creating a session. With Composite 
selected, no nodes are added by default. The session is ready for you to add 
whatever nodes you like.

• Whichever type of new Session is created, an Output node is always automatically 
added and it determines the file format, file name, disk storage location, and 
channels to be rendered.
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Source Settings
Source settings such as field handling are now edited in the Object window. 

Click on a clip in the Sources window to display its parameters. 

Sources Window
The Project window has been replaced with a Sources window where source 

media can be displayed in a thumbnail format.

Stabilize and Shape Bounding Box Points Appearance
The shape bounding box points nested within layers with extreme transforms 

now appear normal when Viewer > Stabilize is enabled.

S3D Node Removed
The S3D node has been removed and replaced with the Depth node.
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